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ABSTRACT
XRF core scanning has evolved to become a standard analytical technique for the rapid 

assessment of elemental, density and textural variations in a wide range of sediments 

and other materials, with applications ranging from palaeoceanography, 

paleoclimatology, geology, and environmental forensics to environmental protection. In 

general, scanning provides rapid, non-destructive acquisition of elemental and textural 

variations at sub-millimetre resolution for a wide range of materials. Numerous 

procedural adaptations have been developed for the growing number of applications, 

such as analyses of unconsolidated, water-rich sediments, powdered soil samples, or 

resin bags. Here, practical expertise and guidance from the Itrax community, gained 

over 15 years, is presented that should provide insights for new and experienced users.

Keywords: XRF Core Scanning; Itrax; X-ray fluorescence; X-ray radiography; 

geochemistry

1 Introduction
After the initial experimental proving phase of XRF core scanning, which started more than 

two decades ago, this analytical method has now developed well beyond its pioneering phase 

to become an indispensable standard technique in many fields (Croudace, 2003; Croudace et 

al., 2006; Croudace and Rothwell, 2015b; Haschke, 2006; Jansen et al., 1998; Richter et al., 

2006; Rothwell and Croudace, 2015; Weltje et al., 2015; Weltje and Tjallingii, 2008). During 

the XRF Core Scanning 2017 international meeting at the National Taiwan University in 

Taipei, Taiwan, which for the first time brought together representatives and users from all 

the main XRF core scanner brands, a large number of interesting new applications using the 

XRF core scanning technique were presented. Based on the progress made over the last 

decade or so, a review summarizing the different operating protocols that have been 

developed for the Itrax XRF Core Scanner (Cox Analytical Systems, Gothenburg, Sweden) is 

timely. The Itrax XRF core scanning procedure may be subdivided into a number of steps: (1) 

instrumental checks to ensure that the machine is operating properly, (2) sample preparation, 

(3) choice of sample holders for core or discrete samples, (4) surface scan to ensure samples 

are level and to make any adjustments for problematic samples, (5) X-ray radiography, (6) 

choice of optimal XRF scanning parameters such as exposure time, step size and X-ray tube 

settings, (7) post-analysis processing of data, and (8) efficient data visualization. For many of 

these steps, various practical solutions developed by Itrax operators worldwide are presented 



for the benefit of other users. We break the coring process down into its different components 

and illustrate the various approaches that have been developed to improve or facilitate the 

processing of different kinds of samples and materials. The structure of this article therefore 

follows the workflow of analysing samples using the Itrax XRF Core Scanner.

2 Pre-analysis considerations

2.1 Instrumental checks
The stability of an instrument influences its analytical performance and regular checks can 

assure that an individual instrument is performing correctly. It is advisable to perform the 

checks on a weekly or monthly basis and always following a tube change. A written record of 

each check-up is kept so that changes in the instrument can be assessed. While this procedure 

should be tailored for each instrument, a basic version is described here (Table 1). 

Table 1. Instrumental checks to be performed on a regular basis.

Component Description

1. Cooling

system

Record the cooling water flow rate and the chiller temperature. 

The latter should be around 20°C depending on the cooling 

system. If you have a filter, note its status and any need for 

change.

2. Safety

interlocks

Using the HV panel or the software set the voltage and current to 

10 kV and 5 mA. Open the shutter by pressing F4 on the HV unit 

or using the drop down option under Operate. Check each of the 

three lids in turn re-opening the shutter for each

3. Surface scan Make a surface scan of the acrylic-block. Check that the 

illumination tubes are working properly and compare the 

measurement scales on the Core Scanner Panel with those on the 

acrylic-block. You should see the step wise pattern of the Al 

staircase in your surface scan height data. 

4. Optical image Save the optical image under File > Save optical image using a 

designated folder and the convention Optical Image-Year-Month-

Day.

5. Radiation

protection

Check the radiation by setting the acrylic-block so that the Al 

portion is under the beam. Set the voltage to 60 kV creating the 

most X-ray scatter and generating the ‘worst case scenario’. 



Using the dose meter check for radiation along the seams of the 

main tower and wings. Note the counts per second. This should 

be low (<2 cps).

6. Line camera 

signal

Move the acrylic-block home and set the radiographic parameters 

to a standard setting that you use consistently for each check-up 

(e.g., 40 kV, 20 mA and 25 msec). Exit the Set Radiographic 

Parameters and using Window> Show Line Camera Signal. The 

signal will appear in black. Load the last reference signal 

(Reference Files > Load Reference), which should be the red line 

on the Radiographic Signal panel. The black and red lines should 

overlap. If there is more than a 10% difference, change the 

alignment of the optics. This is done using the right hand knobs 

on the front of the machine (be sure to retract the XRF detector 

before doing so). Note the value for the black line and then Clear 

the Ref Signal. Press Reference File > Save Ref Signal and save 

it as a dated file (Tube-Year-Month-Day) in a designated folder.

7. XRF 

performance

Move the block to where the reference glass sits. Press Set XRF 

Parameters. Re-enter lab specific standard settings (e.g., 30 kV, 

35 mA and 100 sec) and let the analysis run for the designated 

time and apply a pre-established settings file for the reference 

glass. Note the ICR, OCR, MSE and peak area of the most 

common elements (e.g., Si, K, Ca, As, Zr and coh peak). These 

should be roughly the same as the previous check-up. Note with a 

+ or – sign whether value have gone up or down. Save the spectra 

under File > Save Spectra. When ready with this open the latest 

background spectra found under File> Open Background Spectra. 

There should be good overlap between the pink (background 

spectra) and the newly measured spectra (black). Note if these 

differ significantly.

8. Documentation Set up separate folders to save the optical images, radiographic 

signals and XRF glass spectra. Also copy the XRF data and insert 

the optical image in a designated file (e.g., ppt) recording the tube 

used and the date for each check-up file.



By collecting the above information over a longer time period it is possible to better diagnose 

and solve problems when they do occur since individual users will know what is normal for 

their instrument. 

2.2 Sample preparation and surface scan
Although XRF core scanning in itself is non-destructive, sample preparation may damage the 

material or possibly render it unusable for subsequent analysis. In the Itrax system (a 

contactless/stand-off instrument), the X-ray tube remains fixed and the sample is moved 

beneath the detector. This design differs from most competing instruments that use low 

power.  The Itrax X-ray tube is a high voltage unit that is physically quite large and requires 

an HV cable attachment and water cooling.  While the detector can move up and down to 

some extent to accommodate for variations in the microtopography of the sample surface, a 

smooth and even surface is essential for reliable results. A bubble level is a useful tool to 

ensure/verify that samples are essentially horizontal/parallel to the sample holder. If they are 

not level over the scan length then users should make adjustments by judicious packing with 

low density materials such as folded paper or Clingfilm. Sample surfaces that are not flat can 

be improved by scraping the core with a broad spatula (perpendicular to the long core axis to 

avoid cross-contamination and damage to core textures). This is also often required when 

cores have been stored and oxidized/saline layers have formed. In cores with high organic 

content, cores that have remained in storage for an extended period, or other samples, such as 

hard rock cores or cave carbonates, cracks, holes, or breaks in the sample surface may cause a 

variety of problems. Because measurements are recorded continuously as the core moves 

below the detector and are stored as data at the mid-points of each step, cracks and other 

disturbances cannot be avoided by choosing a step size that omits individual cracks and gaps. 

Furthermore, larger cracks and gaps may cause the detector to move away from the sample 

surface as these are treated as “no go” zones in order to prevent damage to the XRF detector. 

This lifting and lowering of the XRF detector over intervals with cracks may result in the loss 

of data. One way to circumvent this is to apply a thin, removable PTFE 

(polytetrafluoroethylene thread seal tape) tape along the scan path of the laser distance meter 

during the initial surface scan to simulate a smooth surface. After completion of the 

topographical scan the tape is removed, and the detector will pass over the cracks during XRF 

scanning without any adjustment in height (Figure 1). The cracks can often be easily 

identified by abrupt increases in Ar, an element that is abundant in the air in the cracks, and 



removed from the dataset without influencing nearby regions. Operators should remain alert 

to possible Ar peaks indicative of core-surface degradation. Cores with thin, organic-rich, or 

laminated sediment may have been observed to dry out so fast during analysis that cracks not 

visible during preparation or pre-scan have formed during the scanning process. The use of a 

XRF film (e.g. Mylar or polypropylene) helps to reduce drying but the user needs to ensure 

that an X-ray absorbing surface water layer does not form as this will influence the XRF 

scanning data.

A loss of data similar to that caused by core surface cracking can occur at the end of a core 

section because of the abrupt drop in the surface topography. The drop must be avoided by 

the XRF detector in order to protect the detector from damage. The raising of the detector 

means that the last several mm of core analysed may be biased by a larger distance between 

the detector and sample’s surface. This can easily be circumvented by placing a piece of 

“dummy core” level with the core surface at the end of the sample (Figure 1A and 1B, a 

white tape was placed in the end of the core to the left). Phenolic foam (Floral Foam) is of 

practical use as it is easily detected by XRF due to its low density, and can be easily sliced to 

accommodate most sample holders and sample shapes.

In some cores where the sample surface has subsided due to sediment flow or compaction, 

the sediment may have to be elevated to measuring distance of the detector by inserting 

planar or wedge-shaped objects below the sediment. In the case of lacustrine cores retrieved 

by Russian Corer, the sample material is often considerably smaller than the PVC-liner in 

which it is stored. Here the sample can be flipped onto an acrylic glass board so that the 

curved, outer side is measured. In this way the detector will not be hindered by the protruding 

edges of the liners (Figure 2). 

An alternative method, somewhat similar to the method described above for the Russian 

Corer, has been used to scan whole-round lake sediment cores collected using a Geo Core 

(Columbus, Ohio) corer. The procedure involves carefully extruding the sediment from the 

aluminium core tube onto industrial-grade cling film. The best and largely flattest part along 

the core length is covered with a length of 2 m XRF film. The whole sediment core is then 

gently rolled onto the cling-film to form a sausage-shape. This can be rolled onto 

structureless MDF board for safe storage.  When the core is ready to be run on the Itrax the 

Cling-film is carefully peeled back to reveal the 2 m XRF film (Figure 2). The core 

‘sausage’ is then adjusted on a flat board so the XRF film is uppermost. The board, with its 



level core surface (analogous to surface in Fig 2.B) can be loaded onto the Itrax sample 

holder ready for scanning.

2.3 Types of sample holders
During scanning, the core sections are placed onto a tray that incrementally moves cores past 

the measuring unit in the central chamber of the XRF Core Scanner. The tray has adjustable 

rails that allow the sample height to be adjusted, and the tray may also be shifted to the left or 

right to avoid problematic sections or intervals that have been sampled for other analysis. A 

special adapter is also available to accommodate the scanning of U-channels used for paleo-

magnetic studies. However, for non-standard samples innovative solutions may be necessary. 

Below, approaches to measure still frozen freeze-core samples, powdered samples, and resin 

samples are described.

2.3.1 Freeze core vessel
Sediment near the surface-water interface in many lacustrine environments consists of a 

poorly consolidated colloidal soup that is difficult to sample using conventional coring 

techniques without causing homogenization of the geochemical record. This is of particular 

importance in environments with low sedimentation rate where the upper few centimetres can 

represent centuries of deposition (e.g. the Canadian Arctic, Crann et al., 2015). Furthermore, 

this poorly consolidated material is not cohesive enough for XRF core scanning. Freeze 

coring freezes sediments in situ to the coring device and preserves the stratigraphy of the 

sediment-water interface. Here we describe the construction of a novel sample holder capable 

of maintaining freeze core integrity for more than two hours and methods for analysing the 

freeze cores. 

An Ice Box Freeze Core holder (iBox-FC) was created to ensure short slabs of freeze cores 

remain frozen during analysis. The iBox-FC consists of an open-topped box constructed from 

3-cm-thick Styrofoam that is divided into 9 chambers using high density polyethylene 

(HDPE) and filled with freeze pack gel (e.g. hydroxyethyl cellulose (Cellusize), sodium 

polyacrylate, or vinyl-coated silica gel); the central chamber is only partially filled to 

accommodate freeze core material (see Figure 3 and Gregory et al., (this issue) for detailed 

dimensions). Short slabs (~12.5 cm) of frozen sediment slotted into the central chamber of 

the iBox-FC show minimal melting (< 1 mm) after 2 hours of analysis. As water can damage 

the Itrax XRF Core Scanner, all joints of the iBox-FC should be sealed with silicone gel, and 

the outer chambers of the iBox-FC covered with an HDPE lid during analysis (Figure 3C). To 



facilitate easy removal of freeze core material, and to minimize contamination risk, it is 

recommended that freeze core sections be placed in a separate container sized to fit within the 

central chamber of the iBox-FC. The design presented here uses polypropylene boxes (US 

Plastics Corp. 20 dram Flextop box, product #201214; 13.4 cm long, 4.1 cm wide and 1.8 cm 

deep.

Freeze cores must be sub-sectioned longitudinally and latitudinally to fit inside the iBox-FC. 

Following initial cleaning, freeze cores are sectioned into small slabs using a hacksaw and a 

ripsaw. Hacksaws should be used for latitudinal cuts as their thin blade minimizes material 

loss. A rip saw, which has much larger teeth, is more efficient for longitudinal slices, 

reducing time required for freeze core subsectioning. Freeze core slabs should be cleaned 

after they are sectioned to minimize risk of contamination from sub-sectioning instruments. 

During this final cleaning stage, the freeze core surface undergoing analysis should be made 

as smooth and level as possible. A clean microscope slide can be used to scrape the surface of 

the core to provide a smooth surface for analysis. If the core surface is too uneven to be 

levelled by removing the upper few millimetres of core surface, HDPE shims placed inside 

the inner box can be used to level the core. The iBox-FC must be completely frozen before 

freeze core slabs are added, otherwise the freeze core slab will melt before the iBox-FC 

freezes completely.

Once the iBox-FC is removed from the freezer and the freeze core slab inserted into the 

holder, a thin bi-directional PET film with a thickness of 1.4 m must be affixed to the core 

following typical XRF core scanning procedure. The surface of the freeze core slab must be 

melted slightly by exposing the core surface to a heat source to affix the PET film, as the film 

does not adhere well to low-moisture surfaces. After the PET is affixed to the core surface, 

the iBox-FC can be slotted into the Itrax XRF Core Scanner with the rails at the lowest 

setting (Figure 3C).

Afterwards, analysis proceeds following standard Itrax analytical procedures (Croudace et al., 

2006; Gregory et al., this issue). Depending on the thickness of the freeze core slab and 

ambient temperature, freeze core slabs will remain cohesive for at least two hours with the 

Itrax XRF Core Scanner settings being adjusted to accommodate this timeline. If higher 

resolution or longer exposure times are desired during analysis, smaller freeze core slabs may 

be required. During initial testing, X-ray imaging of cores was excluded due to time 



constraints and possible interference of the signal from the iBox-FC. If X-ray imaging is 

desired, analysis should take place in a separate run from XRF analysis, and the freeze core 

returned to the freezer in between runs. 

Initial testing of the iBox-FC took place at McMaster University in Hamilton, 

Ontario, during humid summer months. As a result of the humidity, small water droplets 

formed on the PET film on the surface of the freeze core. During re-analysis of the same 

slabs in the subsequent fall, condensation was greatly reduced. We recommend analyzing 

freeze cores either during less humid months or in a climate controlled room. 

Once Itrax XRF Core Scanning analysis is complete, data from freeze cores must be 

distinguished from that of non-core material. Comparison of core images to XRF Core 

Scanner results using Redicore software (Cox Analytical Systems, Gothenburg, Sweden) is 

useful for this purpose, particularly when examining abrupt changes in major element 

concentrations, total counts per second, sample position, and the total length of core slabs 

recorded during sub-sectioning (Figure 4). Preliminary iBox-FC results show edge effects 

that occur through the lowermost 5 mm of freeze core slabs during analysis. These edge 

effects result in decreased elemental concentrations and increased X-ray scatter when 

compared with the rest of the slab (Figure 4; see Gregory et al, this issue, for additional 

discussion). The use of elemental log-ratios when reporting the data nearly completely 

mitigates these edge effects, and also minimizes subtle amplitude changes in elemental 

concentrations caused by minor shifts in the freeze core height relative to X-ray source 

between freeze core sections. It is thus recommended that elemental ratios or elemental log-

ratios be used (e.g., Kylander et al., 2011; Gregory et al., this issue; Löwemark et al., 2011; 

Weltje and Tjallingii, 2008) as a matter of course for interpretation of geochemical data 

generated from freeze cores subsequent to analysis using the Itrax XRF Core Scanner. 

2.3.2 Scanning freeze dried sections
Another method of dealing with unconsolidated sediments is to freeze dry the samples. This 

removes the water in the sediment, one of the potential matrix issues with XRF core 

scanning, but retains the structure of the material. This technique was developed using 

samples from Nylandsjön in northern Sweden, which has been monitored and sampled yearly 

since 1979 (Galman et al., 2008; Renberg, 1982; Rydberg, 2008). Sediment cores are kept 



frozen from the time of collection until freeze-drying. Core slabs ~1 cm thick and 3 cm wide 

are placed on plastic trays and supported with foam to maintain the physical integrity of the 

sample during freeze-drying (Figure 5a). The entire tray is then placed in the Itrax and 

scanned using standard procedures for scanning sediment cores. In samples with horizontal 

varves good reproducibility between parallel scans is observed although some signal 

smearing is likely (Figure 5).

2.3.3 Discrete samples and powdered samples
The measurement of discrete powdered environmental samples with an Itrax XRF Core 

Scanner is a time- and cost-efficient alternative to conventional wavelength dispersive (WD)- 

or energy dispersive (ED)-XRF analyses when quantitative data are of subordinate 

importance (Profe and Ohlendorf, 2018). Since the Itrax XRF Core Scanner is designed for 

continuous measurements of sediment cores, but not for discrete samples, a sample carrier 

was designed that allows the measurement of discrete powdered samples in scanning mode 

(Ohlendorf, 2018). One carrier holds 30 sample cups with a volume of 0.88 cm3 each. The 

shape and dimensions of the sample cups are adjusted to the measurement geometry of the 

Itrax XRF Core Scanner. A maximum of five carriers, i.e. 150 sample cups, can be measured 

in one run with a step size of 5 mm and a count time of up to 100 s per sample. Subsequent 

data processing for such a run involves deletion of every second spectrum which are biased 

by the acrylic glass rims of the sample cups (Ohlendorf, 2018), recalculation of a new sum 

spectrum containing sample spectra only, fit optimization of the new sum spectrum and batch 

processing of the sample spectra. This measurement protocol was applied to samples of 

several loess-paleosol sequences as these are usually discretely sampled and characterized by 

silt-sized particles which facilitates sample preparation (Profe et al., 2018a; Profe et al., 

2018b; Profe et al., 2016; Zolitschka et al., 2014). All measurements yielded good data 

repeatability with a mean relative standard deviation of < 1.5 % for main elements except for 

Al (14.3 %) and Ba (14.9 %).

Other discrete sediment sample holders have been designed for analysis of sediment 

samples using the Itrax XRF Core Scanner, with minimal pretreatment (unpowdered, semi-

dry, paste consistency, samples). The carrier described here is particularly useful for cost-

effective determination of spatial patterns from landscape derived terrestrial, marine and lake 

bottom sediment samples or for analysis of severely degraded core material.

It is an easy-to-assemble, low-cost, acrylic sample carrier that holds up to 60 discrete 

samples designed to analyse discrete sediment samples by arranging them sequentially in 1.5 



cm3 (1.5 x 1 x 1 cm) sample reservoirs to mimic the orientation of standard sediment cores 

(Figure 6). The Itrax XRF Core Scanner can accommodate two of these sample carriers at 

once to allow analysis of up to 120 discrete samples in one run at high resolution. The 1.5 cm 

surface length scanned by each sample carrier provides multiple measurements of the same 

discrete sample to provide an understanding of the XRF Core Scanner precision for each 

sample as well as a determination of sample heterogeneity. Sediment samples are prepared 

for analysis by centrifuging (4 minutes at 4000 rpm minimum recommended), decanting the 

supernatant, and then drying samples at room temperature until they reach the consistency of 

paste. Sediment samples can then be loaded into the sample carrier and analysed following 

standard Itrax XRF Core Scanner procedures. A simple brass cover (Figure 6C), which 

isolates previous and subsequently loaded sample cups, prevents cross contamination, and 

facilitates rapid loading of the sample carrier. For analysis, the sample carrier is placed on the 

Itrax-XRF Core Scanner rails at the highest setting. Post-analysis data processing must be 

undertaken to remove the acrylic borders from the dataset. These borders can be easily 

identified and removed based on abrupt decreases in the ratio of incoherent/coherent X-ray 

scatter and abundant elements (Fe and Ca are typically useful), as well as a sharp increase in 

the total counts per second (Gregory et al., 2017). 

2.3.4 Ion exchange resin samples
Sample cups used for powdered material can also be applied to pollution monitoring studies. 

As a passive sampling sorbent, ion exchange resins take up many cations relevant for 

environmental studies and can be immersed in natural waters for a fixed period of time for 

monitoring purposes (e.g., Van Grieken, 1982). The rapid uptake rate and low cost of resins 

provide a simple method to record pollutants and allow for a high sampling density, but it can 

also be difficult to digest such amounts of samples with conventional chemical extraction and 

analysis procedures. Therefore, the Itrax-XRF core scanner has been introduced to analyse 

element concentrations in resins. Unlike sediment samples, which usually have high 

heterogeneity due to the variability of physical properties and sample matrix, the dry and 

homogenized resins can minimize interference, making them ideal samples for XRF 

scanning. 

The resin samples can be placed into the sample cups described above, and covered with 

a 1.4 m thin Mylar X-Ray Film to prevent contamination and disturbance by static 

electricity, and then scanned with the Itrax XRF Core Scanner. With 100 seconds exposure 

time, the correlation coefficients between scanning intensities and reference concentrations of 



laboratory-prepared reference resins are all higher than 0.97 for pollution related elements 

such as Cr, Mn, Ni, Cu, Zn, and Pb. Moreover, as suggested by Huang et al. (2016) from the 

experience of sediment reference standards, the strong linear relationship between scanning 

intensities and reference concentrations of resins remains similar even with exposure time as 

brief as 1 second. Thus, this method provides a fast and inexpensive method to quantitatively 

assess multiple element concentrations in the resins, and can be used as an environmental 

monitoring tool for large geographic areas in order to understand the variations of 

environmental contaminants across a landscape. 

2.4 Considerations for special sediments/substrates
Lithified sediment and rock samples can be successfully scanned with the Itrax XRF Core 

Scanner, although XRF core scanner operators must be cautious of possible issues arising 

from the crystalline nature of some rock samples. For example, Miocene sandstones from 

outcrops in NE Taiwan containing numerous diagenetically altered trace fossils (Löwemark 

et al., 2016) were scanned using the Itrax XRF Core Scanner. Mineralogical thin section 

analysis of these trace fossils is time consuming and cumbersome. Alternatively, using the 

Itrax XRF Core Scanner, and aligning structures of interest perpendicular to the scanning 

direction, interesting results were obtained. Using this method, a scan comparing the 

elemental composition of the trace fossil Ophiomorpha to surrounding sediment revealed 

significant enrichment of Fe and Ca in the walls of the tubes, explaining their greater 

resistance to erosion (Figure 7). 

It is also possible to analyse rock samples. Skelton et al. (2010) used XRF Core 

Scanning to examine freshly cut, flat, unpolished rock cross section in order to characterize 

chemical mobility related to the segregation of epidote. The resulting XRF spectra were 

inspected for possible diffraction lines that could have been caused by the crystalline nature 

of the material subject to analysis. However, diffraction lines were found to be minimal and a 

clear change in major elements (Al, Si, Ca and Fe) was observed across the margin of epidote 

segregations, providing invaluable insight into mobility of these elements (Skelton et al., 

2010).

The measurement of Ca-rich samples such as speleothems can cause considerable analytical 

challenges due to the formation of Ca sum peaks that can distort element signals. In the case 

of a speleothem-based flood history, however, Finné et al. (2015), were able to easily identify 

the intervening mineral-rich layers using XRF Core Scanning. This provided information 



comparable to conventional thin section analyses more commonly used to develop 

speleothem-based flood history (Finné et al., 2015).

3 Analysis of sample

3.1 X-ray radiography

3.1.1 A radiograph standard
When scanning a large batch of core sections from a long sediment section, the radiography 

settings might not be similar from one section to another. Indeed, sediment density or 

composition may change with depth (e.g. compaction, lithological changes) and the operator 

needs to adjust radiographic settings in order to maintain a good radiography quality. 

Performing a scan of the acrylic-block for every run is not practical because of its relatively 

large size (26 cm of scanning space). An alternative to the acrylic-block is a more compact 

version of the aluminium staircase included in the acrylic-block (Francus et al., 2015), that is 

only 2 cm thick and can be placed at the beginning or the end of each sample or core section, 

hence minimizing the amount of additional time needed to include a radiographic reference in 

each run. This radiographic reference sample allows for optimizing the voltage, current and 

dwell time independently for each run, and, during the post-analysis step, to bring all sections 

on a common X-ray attenuation scale using a simple image analysis protocol (Francus et al., 

2015). Furthermore, monitoring of this radiographic reference sample can be used to identify 

drift of the X-ray tube and aging of detector and is indispensable for inter-laboratory 

comparison purposes.

3.1.2 Combining overlapping images
While optical images taken by an Itrax Core Scanner typically cover the entire width of a 

core sample, radiographic images are limited to a width of 17.6 mm by the size of the X-ray 

tube. This results in a narrow radiographic image along the centre-line of the core section, 

covering only a small fraction of a typical core sample. To increase this limited coverage, it is 

possible to run repeated scans along different offsets from the sample centre. Besides the 

standard centre position, the core sample holder can be manually adjusted to 1 or 2 cm in 

either direction perpendicular to the movement of the sample in the scanner. Several 

radiograph-only scans can be performed in just a few hours. A maximum of 5 images (center-

scan + 1 and 2 cm offsets to each side) can then be combined with image-processing software 



such as Adobe Photoshop to create a composite image of up to 57.6 mm total width. Figure 8 

shows an example of a composite image produced from 3 overlapping scans. 

Sediment cores are typically cylindrical which results in thinning of the sediment 

package when moving outwards from the centre-line. This is also visible in Figure 8, where 

the image appears lighter further away from the centre along the y-axis. Operators can 

compensate for this by applying a graduated brightness filter in Adobe Photoshop. 

3.1.3 Post-processing of RAW files
The radiographic images produced by the Itrax XRF core scanner are composed of individual 

line scans, with 188 µm spacing in the direction of core movement. This results in a 

resolution of approximately 5 pixels/mm in the final radiographic image. The individual line 

scans however, contains 891 pixels in the 17.6 mm beam width, corresponding to 

approximately 50 pixels/mm. To compensate for this non-equal distribution of pixel density 

along the different axes of the dataset, the final .tif image exported from the Itrax software 

contains 5 pixels/mm in both directions. The data is thus downsampled to create square-

shaped pixels. However, a radiographic scan from the Itrax XRF Core Scanner, produces not 

only a .tif file with the radiographic image but also a .raw file that contains all the raw data. 

In the .raw file all the individual line scans with full resolution are preserved. Rather than 

downsampling in one direction, a MATLAB script was developed to upsample the other 

direction (Supplementary File 1). The script produces a high resolution radiographic image 

based on the .raw file with square-shaped pixels, by keeping the original 50 pixels/mm 

resolution of the line scans, and interpolating the lower resolution 5 pixels/mm in the x-

direction using a spline interpolation to the same resolution (Figure 9). The same script also 

automatically adjusts the intensity levels of the image based on the data in the .raw file. This 

creates an image with consistent brightness and contrast adjustments which are normally 

done in either RediCore or Adobe Photoshop. 

3.2 XRF scanning quality and precision issues

3.2.1 Choosing optimal exposure time
Minimizing the measuring time when analysing material with the Itrax XRF Core Scanner is 

especially advantageous when dealing with large volumes of core material. However, 

exposure times of XRF Core Scanners used by different researchers for different materials 

vary greatly (Table 2). This depend partly on the generation of the detector owned by the 

Itrax user since count-rate capability has increased significantly (approximately 10 times) 



since the original scanner was produced in 2003 (Croudace et al, 2006). Finding the suitable 

minimum exposure time for the scientifically relevant elements is essential in order to obtain 

reliable data efficiently. To test the minimum acceptable exposure times for different 

elements, silt- and clay-rich lake sediment (TOC: 1.7-4.2 %), samples where repeatedly 

analysed with decreasing exposure times ranging from 100 to 3 seconds (100, 80, 60, 50, 40, 

30, 25, 20, 15, 10, 8, 7, 6, 5, 4 and 3 seconds) and different voltages and currents (30 kV, 30 

mA; 30 kV, 55 mA; 40 kV, 30 mA) using a Mo X-ray tube. Acceptable minimum exposure 

times should meet the following three conditions: (1) the peak area of high-sensitivity 

elements (S to Pb) must surpass between 0.0001 and 0.5% of the total peak area and the peak 

areas of low-sensitivity elements (Al and Si) must be <5% of the total peak area to be 

considered accurate (Marshall et al., 2012); (2) For a given scan time, there is no zero value 

for the peak area; and (3) down-core trends in elemental peak areas throughout a given core 

section show the same trend between the suitable minimum exposure time and 100 seconds. 

The results show that for most elements, an exposure time of 7 seconds (using a 

silicon-drift, 7mm2, "reset" model, low volume detector) is sufficient to obtain reliable results 

for this lake core (Figure 10). Aluminium and Si, however, required longer exposure times to 

meet the aforementioned criteria than was required for other elements. Increasing the current 

(mA) allows reduction in the exposure time required to meet minimum precision 

requirements, although increasing the voltage does not have a substantial influence on 

minimum possible exposure times. 

Table 2. Variations in exposure times used for different sample types scanned with the Mo 

X-ray tube on the Itrax XRF scanner.

Sediment Core Type Exposure time Voltage and current Reference

Lake Bramant (fine detrital clays, 

TOC: 0-4%)

10 s (Guyard et al., 2007)

A variety of sediments: sandstone 

reservoir rock; muddy marine 

sediment with low carbonate 

content, petroleum and carbonate-

rich shale laminated

100 s 30 kV, 30 mA (Croudace et al., 2006)

Yarra River sediment core (clay lake 

sediment core)

10 s 30 kV, 45 mA (Lintern et al., 2016)



Suigetsu lake sediment core (clay lake 

sediment)

20、10、6、5, 4 s 60, 50, 40, 30 kV, and 

40, 30 mA

(Marshall et al., 2012)

Sand and siltstones, tills and 

meltwater deposits, total inorganic 

carbon (TIC) = 8.33 %

10 s 30 kV, 40 mA (Buechi et al., 2017)

Marine sediment core (sand and clay, 

TOC: 0-4.5%)

20 s 30 kV, 40-50 mA (Shi et al., 2016)

Marine sediment core (high Corg 

clayey sapropel units)

35 or 45 s 55 kV, 50 mA (Thomson et al., 2006)

Paddy's Lake sediment core (bulk 

sediment rich in organic matter)

10 s 30 kV, 55 mA (Beck et al., 2017)

Marine sediment  linking to volcanism 

(silt and clay)

10 s (Gjerløw et al., 2016)

Lacustrine sediments (gravel, sand 

and silt/clay)

5 or 10 s 30 kV, 40 mA (Barrett et al., 2017)

Marine sediment core 

(glacial/interglacial sedimentation, 

silt-clay)

20 s 30 kV, 55 mA (Plaza-Morlote et al., 

2017)

3.2.2 Replicate measurements
The accuracy and precision of element intensity records acquired by XRF scanning has been 

a subject of debate since the introduction of XRF core scanning devices (Croudace et al., 

2006; Jansen et al., 1998). Calibration of element intensities with absolute concentrations 

obtained from reference samples is often used to prove the accuracy of XRF measurements 

but does not disclose information on the precision of these measurements. Moreover, the use 

of discrete reference samples for calibration reduces the non-destructive advantages of XRF 

scanning records and introduces additional uncertainties arising from differing sampling 

resolutions, sample inhomogeneities or sample preparation. However, replicate 

measurements can provide a non-destructive indication of the precision of XRF scanning 

records after log-ratio transformation (Weltje et al., 2015; Weltje and Tjallingii, 2008). If 

replicate measurements are provided, statistically robust confidence limits (90, 95 or 99 %) 

are provided by the XELERATE software package (Weltje et al., 2015). Additionally, the 

software utilizes replicate measurements to assess the correlation significance provided by 

multivariate biplot analyses (Bloemsma, 2015). 



Standardized acquisition of replicate measurements (e.g. i measurements every nth 

sample) is not facilitated by the Itrax acquisition software and need to be assigned manually. 

Ideally, the number of replicate measurements should be proportional (ca. 5-10% of total data 

points) to the scanning resolution, the lithological variations, and the time available. 

Representative replicate measurements should cover both sedimentological extremes and 

average sediment compositions. Therefore, selecting two to three intervals (e.g. top, middle, 

bottom of the core section) for replicate analyses that cover lithological transitions or 

representative variations of the core lithology is most suitable. 

Since XRF scanning can provide multi-elements data in a single scan, a simple method to 

quickly evaluate the credibility of each element is needed.  One way to address this is to 

calculate the correlation coefficient of each elemental intensity between replicate 

measurements. Such information is useful to decide which element can be reproduced by the 

XRF scanning method. The relationship between correlation coefficient and average scanning 

intensity is also helpful in determining the signal-to-noise ratio of individual elements. 

3.2.3 Estimating signal-to-noise ratios to assess Itrax XRF data quality

Estimating signal-to-noise ratios (SNRs) using the measured XRF spectra has at least two uses 

in Itrax XRF core scans. First, the quality of data that will be obtained at a site using different 

combinations of tube voltage, tube current and exposure time can be assessed using a series of 

test scans of a short section of core. Second, element profile suitability for interpretation of 

environmental change can be assessed after data acquisition.

The simple method for estimating SNRs developed by Ernst et al. (2014) for use in 

XRF analysis of glass fragments can be applied to Itrax XRF scan spectra. This method requires 

the definition of three ranges of channels within the XRF spectrum for each element, which 

can be based on the sum of spectra. These are the ranges of the XRF background on either side 

of the element peak and of the peak itself. Mean counts are calculated for each of the two 

background ranges, with the mean of these two values multiplied by the number of channels 

beneath the peak equal to the XRF background and the square root of this value representing 

the noise. The background is subtracted from the total counts in the channels within the element 

peak range to give the signal. A detailed explanation of the steps involved is given by Ernst et 

al. (2014).

These calculations can be performed rapidly on all spectra in a scanned core section 

using simple computer code. Apparently, negative SNRs can occur where the total counts in 



channels beneath the element peak are less than the mean background value multiplied by the 

width of the peak. The distribution of SNRs for an element within a scanned core section can 

be expressed using percentiles, allowing comparison of the limits of detection limits of 

quantification and between series of test scans.

As an example, distributions of SNRs for Rb and Zr obtained in series of scans using different 

combinations of tube voltage and current for test sections in floodplain cores from the River 

Boyne (Ireland), and River Severn (UK), are illustrated (Figure 11). The importance of these 

two elements is in their use in the Zr/Rb log-ratio, a grain size proxy (Jones et al., 2012; 

Kylander et al., 2011). The graphs show that certain combinations of tube voltage and current 

produce substantial proportions of SNRs in the two test sections below the limit of 

quantification. The results suggest that either an alternative grain size proxy or a longer 

exposure time are needed for the River Boyne site, but that a tube voltage of at least 40 kV will 

give acceptable results for the River Severn core. It should be noted that SNRs for Zr scanned 

at 40 kV and 50 kV may be substantially underestimated because of the position of the Zr peak 

adjacent to the Mo incoherent scatter peak, and the resulting curved background beneath it at 

higher tube voltages.

4 Post-Analysis Considerations 

4.1 Data visualization software
The Itrax core scanner produces copious amounts of data. For example, scanning a 1-m 

sediment core on an Itrax at 200 μm increments creates 5000 XRF-spectral data files. 

Graphical image files (optical.tif and radiograph. tif) and a results summary file (result.txt) 

are also created and saved. Efficient display of these data is essential to enable users to 

evaluate, analyze, interpret and present or publish the data. 

RediCore: The Cox Analytical System RediCore program provides some useful visualization 

capability. It includes optical and radiographic image optimization and permits the plotting of 

up to two element profiles over optical and radiographic profiles along with correlation 

coefficients for the pair of variables selected.  

ItraxPlot: There is a clear benefit in viewing multiple element profiles aligned to 

radiographic and optical images. ItraxPlot software (Raddec International, Southampton, UK) 

developed in 2003, allows rapid visualization of Itrax data (Croudace et al., 2006; Croudace 

and Rothwell, 2015a). The package was designed to be intuitive and easy to use and 

incorporates multiple features to effectively display the co-registered datasets of optical and 

radiographic images and elemental depth profiles (Figure 12). The program enables users to 



display, optimize, organize, adjust and analyse their data in just a few seconds. The final 

output selected by the user is suitable for presentations and publications. For maximum user 

flexibility and ability to display different elements, multiple copies of the Program can be 

open on a single computer. This approach allows researchers to rapidly inspect their core data 

and identify anomalies and data artefacts caused by cracked, damaged or sloping surfaces 

before interpretation. The ability to view a broad range of data at the same time helps users to 

evaluate variations in a number of core properties and to infer changes in mineralogy, heavy 

metal pollution signals, sediment accumulation rates, redox variations and much more. 

Following evaluation, users can readily prepare high quality representations for use within 

scientific presentations or publications (Table 3).

Table 3 Summary of ItraxPlot features.

Displays up to ten elemental profiles alongside optical and radiographic images in a single window

Allows optimization and size adjustment of optical and radiographic images 

Allows control of colour and contrast features

Display of optical and radiograph images can be selected/de-selected

Multiple core sections can be stacked to view longer core sequences

Bartington sensor and radiograph ‘grey-scale/density’ data can be plotted along with element data

Normalization of element data by other measured data 

Insertion and plotting of non-Itrax data (e.g. Cs-137, Pb-210 etc.)

Elemental data scaling and intercepts can be adjusted

Modification of text labels and font size

Selection of smoothing/averaging of data for elemental plots

Zoom function to aid study of fine detail

Addition of horizontal and vertical shading or colour to define regions of interest

Addition of vertical and horizontal reference lines

Control of colours on graphics (background, text, data, lines etc.)

Saving and printing of complete ItraxPlot graphic as a .pdf, .bmp or .tif files

Smoothed data can be saved as a .csv file

Three mathematical filtering functions are available to extract time series data (e.g. sediment laminae or tree 

ring counting)

Users can run multiple copies of the program on the same computer to enable visualization of all elemental 

data

iPoint: The commercially developed iPoint suite (developed by Perigon Solutions Ltd) 

provides an alternative method for viewing and investigating Itrax XRF core scanner data. 

This program enables co-visualization of any type of numerical depth-referenced core data 



aligned to optical and radiographic images in one easy to navigate multi-scale display. For 

example, core logging instrumentation, discrete samples, CT scans or hand-drawn logs can 

all be included if required. Each dataset is depth referenced to allow easy initial interpretation 

of complex datasets. The iPoint suite is able to display an unlimited number of Itrax XRF 

core scanner elemental profiles with high-resolution images (Figure 13). Furthermore, the 

program has extensive features for assisting with micro-scale analysis, identification of 

correlation and marker horizons, as well as statistical analysis. A useful feature for an initial 

filter of poor quality data points in Itrax XRF core scanner data is the capability to flag and 

identify anomalies and artefacts in the data, specifically utilizing the validity, MSE, Ar and 

kcps data columns. 

 Xelerate: The Xelerate software offers calibration, plotting and visualization of XRF core 

scanner data (available at www.mennobloemsma.nl/software.php). This software package has 

been developed with the aim to integrate the different data types which are commonly 

acquired from hydrocarbon industry cores (e.g., permeability, porosity, lithofacies). The 

methods, however, are relevant to a much wider field of application than just hydrocarbon 

industry (Bloemsma, 2015). What sets this program apart is that all the tools and methods it 

contains acknowledge the fact that only log-ratios of element intensities have a unique 

relation with compositional variations in the sediment: a property that stems from the fact that 

every scanned data point can have a different measurement geometry (Weltje and Tjallingii, 

2008). Around this central idea, several features have been developed as outlined below.

Quantitative calibration 

Transformation of element intensities into element concentrations is one of the main 

features of Xelerate. The program features the bivariate calibration approach outlined by 

Weltje and Tjallingii (2008), as well as a state-of-the-art multivariate method based on 

Partial Least Squares Regression (Weltje et al., 2015).

Automatic calibration sample selection 

The program selects optimal calibration sample positions, and is aimed at ensuring 

compositional coverage rather than spatial coverage: sample positions are selected by 

employing statistical clustering of log-ratio transformed element intensities.

Core plotting tool

Scan data and automatically selected sample positions can be shown alongside or on top 

of core images. Calibrated scan data can also be displayed, together with the reference 

composition of the standards used in the calibration process (Fig. 14). To facilitate quick 



navigation through the core, the core plotting tool has scrolling and zooming 

functionality.

Biplot tool 

The ability to make biplots facilitates simultaneous inspection of the correlation among 

the logratio-transformed element intensities, and the variations along the core (for an 

example, see Martin-Puertas et al., 2017). Biplots can be constructed from both raw and 

calibrated element intensities.

More details about these methods can be found in Bloemsma (2015). Executables of the 

Matlab-based programs AvaaXelerate (for Avaatech data) and ItraXelerate (for Itrax data) are 

freely available on the internet (www.mennobloemsma.nl/software.php).

5 Conclusions
A number of innovative techniques, methods and tweaks have been developed at different 

Itrax XRF core scanning labs around the world to deal with problematic samples, and 

improve post processing of the data, thus increasing the utility and range of application of the 

various parameters produced by the core scanner.

 Special sample holders have been developed to allow the scanning of frozen 

sediment, powdered samples, and ion exchange resins used in forensic studies.

 Computer scripts have been developed to allow production of X-ray images more than 

three times the width achieved by single run scanning. An algorithm to up-sample the 

produced X-ray images to their maximum resolution has also been developed.

 By extensive testing, the minimum required exposure times have been established for 

a number of elements, allowing the required scanning time to be minimized for larger 

sample sets.

 Statistical methods have been developed to assess the reproducibility of the produced 

elemental data.

 ItraxPlot visualization software was developed to enable rapid inspection of Itrax 

elemental profiles correctly aligned with optical and radiographic images. The ability 

to study a broad range of co-registered profile data has made ItraxPlot an invaluable 

tool for Itrax laboratories.

 iPoint enables co-visualisation of any numerical depth-referenced core data types 

aligned to optical and radiographic images in an easy to navigate multi-scale display.



 Xelerate facilitates analysis, calibration and visualization of element intensity data 

and core photographs. The key feature of Xelerate is that all of its methods and tools 

are based upon analysis of log-ratios of, rather than absolute element intensities.

Core scanning XRF is an invaluable tool for investigating the geomorphological, 

climatological, and contaminant history of environmental systems in marine, lacustrine and 

terrestrial settings. The aforementioned advancements expand the range of XRF Core 

Scanning to new settings initially assumed to be impossible when XRF core scanning was 

first developed two decades ago. However, further advancements are required to improve 

XRF core scanning, including better determination of accuracy and precision of various XRF 

core scanners, rigorous testing of various calibration methods in a variety of settings using 

multiple sample types, methodological adjustments to ensure accurate and precise 

measurement of sample material, and possible development of a more extensive selection of 

sediment standards for use in calibration.
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8 Figure caption

Figure 1. If the sample surface is poor due to gaps, cracks, holes from the removal of 

discrete samples or other disturbances, then a first image obtained is taken and saved (A), 

and the PTFE-tape is applied to cover the gaps above the bi-directional ultra-thin PET film (B, 

C). The surface scan is then performed again, after which the tape is removed and the XRF 

scan can be performed.

Figure 2. (A) Schematic illustration of a Russian Corer and the sampling (as seen from above) 

of sediment within a Russian Corer, resulting in a semi-cylindrical core. (B) The obtained 

core is often considerably smaller than the liner used for storage. If the protruding edges of 

the liner interfere with the safety guards, the measurements will fail. The core is flipped 

onto a board and the analysis is performed on the outer curved part of the core. (C) 

Scanning procedure for whole round Geo Cores. The extruded core is wrapped in cling-film, 

which is peeled back to expose the area at the top of the core that will be measured.

Figure 3. Detailed dimensions for the construction of the iBox-FC (reproduced from Gregory 

et al., this issue). (A) Cross sectional and Aerial views of the iBox-FC showing detailed 

dimensions of Styrofoam box and HDPE dividers. Note: not shown here are the 2 mm wide 

slots cut half way up the height of HDPE dividers at the intersection of long and wide HDPE 

pieces that allow the HDPE to be slotted together. (B) Image showing how the different 

components of the iBox-FC are slotted together. (C) The iBox-FC slotted into the rails of the 

Itrax-XRF-CS at McMaster University, Hamilton, ON, Canada.



Figure 4. Results from scanning a freeze core slab recovered from Control Lake, Northwest 

Territories, Canada. These results are from the first section of core CON01-1FRF1 (top 

picture). The dashed lines correspond to the end of the core, the grey shaded area 

represents a small crack visible on the core image, and the hatched box represents edge 

effects observed in the last ~5 mm of the core.

Figure 5. (a) An example of the freeze dried varve plug supported by foam and plastic during 

freeze drying. (b) When left and right hand scans of the freeze-dried cores were compared 

they were found to match well. 

Figure 6. Schematic image and example of sample carrier capable of analysing sediment 

samples that require minimal pretreatment (modified from Gregory et al., 2017). (A) 

Dimensions of the sample carrier consisting of sequential sample reservoirs. (B) Image of 

the sample carrier before samples have been loaded. (C) The brass loading assistant in place 

on the sample carrier. (D)A fully loaded sample carrier in place on Itrax XRF Core Scanner 

tracks and ready for analysis.

Figure 7. Variations in Ca (orange) and Fe (blue) across the wall material in the wall of the 

trace fossil Ophiomorpha. Dotted yellow line marks the path of the detector over the 

sample. Ophiomorpha is believed to be a dwelling structure constructed by crustaceans. In 

order to stabilize the burrow, the producer constructs a lined wall made up of ovoid pellets. 

Diagenetic processes related to the decomposition of organic material in the pellets may 

lead to enrichment of certain elements, in this case Fe and Ca. 

Figure 8. A composite image of a short section of sediment core made up of 3 overlapping 

scans with different offsets from the centre. Despite significant overlap between the 

individual scans, the image width is increased from 17.6 mm for a single scan to 37.6 mm for 

this triple scan. The mollusc specimen visible in the -1 cm offset scan would not have been 

found if only the standard centre scan was done. Image produced from marine sediment 

core SWERUS-L2-4-PC1 (Jakobsson et al., 2017).



Figure 9. A close-up of the same mollusc highlighted in Figure 8, visualized using two 

different approaches. Left panel: the original .tif image produced by the Itrax software with 

manually adjusted contrast and brightness. Right panel: the same image area, but produced 

from the .raw file using the MATLAB script (Supplementary File 1) which performs a spline 

interpolation along the x-axis of the radiographic image. The pixel density in the right image 

compared to the left image is 10x higher in both directions, but the actual resolution is only 

improved in the y-direction.

Figure 10. The lowest exposure time for each element.

Figure 11. Change in SNRs with tube voltage and current for Rb and Zr in XRF scans of test 

sections from Crewbane Marsh, River Boyne, (left column; CM C1 S1), and the Roundabout, 

River Severn (right column; RO C13 S2) performed at 500 µm resolution and 30 seconds 

exposure time. 

Figure 12. Example of output from the ItraxPlot program. The program allows aligning the 

optical and radiographic images with plots of up to 10 parameters or their ratios produced 

by the Itrax Core Scanner.

Figure 13. iPoint image showing the integration of ITRAX data with core photograph, 

radiograph and core log.  The selected section highlights the variation of major elements 

across turbidite beds from sediment core CD166-19 (Madeira Abyssal Plain).  Data headers 

details the average values for each dataset in addition to range of values. Additional data 

can be displayed within each column if required. MSE column (green) shows the variation in 

Mean Squared Error downcore, and the associated spikes across coarser grained horizons.  

Far right hand column displays a chosen ratio (Ti/K). Ratios can be custom created according 

to user preferences. 

   

Figure 14. Graphs produced with Xelerate that illustrate the functionality of the core 

plotting tool: core photographs (A) can be displayed side-by-side with selected log-ratio’s of 

element intensities (in this case Al/Si) (B), or alongside a selected log-ratio of major-oxide 



abundances, as obtained by quantitative calibration (C). In B and C, a 99% confidence band 

is shown in grey. The width of this confidence band is derived automatically from replicate 

scans for the intensity data, and from the goodness-of-fit for the calibrated intensities, 

respectively. Automatically selected sample positions are indicated in red, whereas 

calibration sample positions are shown in blue. The displayed interval is a part (section 2-1 

until 2-25) of a sedimentary rock core from Carboniferous, retrieved from wellsite E10-3 in 

the Dutch sector of the North Sea (see Bloemsma, 2015).
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